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The PacSAFE project is a response to demand from Pacific Island Countries for tools to better understand disaster
impacts. The project will engage with representatives from national disaster management offices and related agencies
who are involved in planning for, preparing for and responding to natural disasters. The PacSAFE software tool,
initially developed by the Pacific Community (SPC), is a desktop tool based on QGIS and InaSAFE to interact with
hazard and asset data, such as the Pacific Catastrophic Risk and Financing Initiative (PCRAFI) asset database. The
PacSAFE project, funded by the Government of Australia, with technical support from Geoscience Australia, aims to
provide the tools and capability to enhance the ability of disaster managers to make informed decisions for disaster
response and to develop evidence-based policies for enhancing disaster resilience.

Contents 1



PacSAFE Documentation

2 Contents



CHAPTER 1

InaSAFE Training Documentation

Material for training workshops is maintained here. Each training workshop is maintained under a separate subdirec-
tory for completeness. Material may be copied between workshops, but then tailored for the audience.

1.1 PacSAFE Training Workshop - Tonga

Tonga, April 2017

This Training Manual has been prepared for the InaSAFE Training Workshop hosted by National Emergency Man-
agement Office, Tonga (April 2017). Material was prepared by Geoscience Australia and SPC, based on the InaSAFE
training programs prepared by Kartoza.

Preface

As a highly hazard-prone country, Tonga faces significant risk of loss of lives and challenges to development progress
as a result of natural disasters. The development of disaster management plans is seen as an important step to strengthen
disaster risk reduction programs. However, this can only be effective when risk assessments and contingency plan-
ning utilise realistic hazard scenarios. Realistic hazard scenarios require scientific, sound and up-to-date data hazard
information as well as up-to-date, scale-appropriate exposure data. Such map-based risk assessments and contingency
plans contribute to better disaster management planning and response.
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1.1.1 Course Objectives

This InaSAFE training workshop provides a first introduction to the InaSAFE application, what InaSAFE does (and
does not do), how it can be used in supporting disaster management in Tonga, and assess further needs for development,
based on user requirements. By the end of the workshop, participants should be able to demonstrate the following skills
and knowledge:

• General

– Understand the conceptual space in which InaSAFE can be used

– Understand the concept of hazard data

– Understand the concept of exposure data

– Understand the concept of aggregation data

– Understand the concept of an impact layer

– Understand the concept of an impact summary

• Data preparation

– Be able to import a hazard layer and assign it appropriate keywords

– Be able to import an exposure layer and assign it appropriate keywords

– Be able to import an aggregation layer and assign it appropriate keywords

• Analysis – run basic InaSAFE

– Familiarise with the InaSAFE dock, toolbars and data packages/profiles

– Be able to run a cyclone analysis on buildings using InaSAFE

– Be able to generate a PDF map from the results of an analysis

• Analysis – run intermediate InaSAFE

– Be able to define keywords using the InaSAFE keywords wizard

– Be able to run InaSAFE with aggregation data

– Be able to set the analysis area using the InaSAFE analysis area tool

• Analysis – run other hazards

– Be able to run InaSAFE with tsunami hazards

– Be able to run InaSAFE with flood/inundation hazards over infrastructure/population

– Be able to read metadata and assign keywords to hazard data

• Practical application

– Be able to explain the purpose of InaSAFE

– Be able to interpret InaSAFE analysis results and use them in disaster management.

– Configure, update and generate needs analysis for Tonga per hazard

Target Audience

• Persons responsible for developing disaster management plans

• Representatives from NGOs working in disaster risk reduction

• Other relevant organisations and agencies
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Prerequisites

• Ability to operate a computer (word processors, presentations, spreadsheets, internet, etc.)

• Computer with:

– Minimum RAM of 2GB (recommended 4GB)

– Windows (XP, 7, 8, 10), Linux (Training Ubuntu later than 12.04) or similar, MacOSX (Lion – 10.7, Snow
Leopard – 10.6). The workshop materials have been developed using Windows 7;

• Basic skills in Geographic Information Systems (GIS) are an advantage, but not essential.

Credits

InaSAFE is based on QGIS and the InaSAFE plugin, and was originally developed by SPC, funded by the Asian
Development Bank as part of the project Strengthening Disaster and Climate Risk Resilience in Urban Development
(TA-8238-REG).

InaSAFE was originally developed by the Australian Government in partnership with The National Disaster Manage-
ment Authority (BNPB) Indonesia, and the World Bank (GFDRR).

This InaSAFE training manual was developed by Geoscience Australia and SPC, based on the InaSAFE Socialisation
Training Manual (http://docs.inasafe.org/en/training/socialisation/) developed by Kartoza (http://kartoza.com/).

Licence

This training manual is licenced under Creative Commons by Attribution by Kartoza/SPC/Australian Govern-
ment/World Bank-GFDRR.

Authors:

Sachindra Singh, Senior Geospatial Systems Architect - SPC

Craig Arthur, Pacific Activity Leader - Geoscience Australia

Lauren Power, Senior Spatial Analyst - Geoscience Australia

1.1.2 Workshop agenda

The InaSAFE training workshop is facilitated by Geoscience Australia and SPC. The first day of the workshop is
formally arranged, while the later days are flexible to allow for the varying skill level of participants, and any issues
that we might face in relation to installing the software.

Day 1

• Welcome

• Opening remarks

• Introduction to InaSAFE project

• Disaster management in Tonga

• Course overview and introduction to the InaSAFE application
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• Welcome lunch

• InaSAFE concepts

• Introductory exercise: Getting started with InaSAFE

Subsequent days will have a more flexible program, accomodating the different pace of participants working through
the course material.

Day 2

• Review activities from previous day

• Introductory exercise (continued)

• basic-pacsafe

• Recap today’s work

Day 3

• Review activities from previous day

• intermediate-pacsafe

• Recap today’s work

Day 4

• Review activities from previous day

• other_hazards

• Recap today’s work

• Workshop feedback survey

1.1.3 Introducing PacSAFE

The InaSAFE project is a response to demand from Pacific Island Countries for tools to better understand disaster
impacts. The InaSAFE software tool is designed and developed for national disaster management offices and related
agencies involved in planning for, preparing for and responding to natural disasters.

The InaSAFE software tool was initially developed by the Pacific Community for urban planners to interact with
hazard and asset data, such as the Pacific Catastrophe Risk Assessment and Financing Initiative (PCRAFI) asset
database. InaSAFE is built upon the highly successful InaSAFE project (http://inasafe.org) and the QGIS Geographic
Information System (http://www.qgis.org). The underlying goal of InaSAFE is to encourage and facilitate better
planning for disasters - our slogan is “better planning saves lives”.

6 Chapter 1. InaSAFE Training Documentation
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Each country faces its own unique challenges. Based on the Global Assessment Report for Disaster Risk Reduction,
the biggest threats in Tonga are posed by tropical cyclones and storm surge inundation. Other countries will face
different challenges, and these challenges may evolve over time.

Fig. 1.1: Probabilistic risk results for Tonga. GFCF is Gross Fixed Capital Formation. Average Annual Loss is an
indicator of the expected loss per year from hazards, averaged over many years. Source: GAR2015.

The probable maximum loss table indicates the expected level of loss for different return periods. On average, there
will be a tropical cyclone event that results in a loss of around T$130 milion (US$71 million) approximately every

1.1. PacSAFE Training Workshop - Tonga 7
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Fig. 1.2: Contribution to average annual loss from different hazards in Tonga. Source: GAR2015.

Fig. 1.3: Probable maximum loss for different hazards in Tonga. Source: GAR2015.
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20 years. To put that in context, losses associated with Cyclone Ian were estimated at close to T$90 million. With
improved planning and preparation, it will be possible to reduce these losses, which can only benefit the Tongan
community.

The InaSAFE project aims to provide a tool that will enhance the ability of disaster managers to prepare for and
respond to disasters, and to reduce the impacts of disasters on the local population and infrastructure.

Open source

From the beginning, InaSAFE has been an open source project (GPL license). This means there are no licensing
fees, the software can be freely copied and shared with anyone, and the source codes used to create the software are
freely available which means that anyone with a little technical knowledge can contribute to the project. Being an
Open Source project is important for us because we want as many people as possible to be able to use and improve
the software. If ‘better planning saves lives’, having a tool that can be used by everyone to do better planning makes
sense, right?

Open data

A key driving force in the ability to use tools such as InaSAFE is open access to relevant, up-to-date and well main-
tained geospatial data. Without roads, buildings, administrative areas, flood and population data etc., a tool like
InaSAFE would be impossible to use. PCRAFI, OpenStreetMap.org, WorldPop and many government and non-
government organisations around the world have been leading the effort to make such datasets available. We cannot
emphasise enough the importance of government in taking a lead role in making their data freely available so that it
can be used for the benefit of their citizens.

1.1.4 Disaster Risk Management

Before we get into the details of using InaSAFE, we first will look at some core themes of disaster management
planning.

This module aims to provide participants with the following knowledge:

• understand the concepts of hazard, vulnerability, exposure, impact and risk

• understaning the disaster management cycle

• what are risk and impact assessments

Components of impact and risk

Hazard

A hazard is considered any natural or human caused event or series of events that may negatively impact the population,
infrastructure or resources in a community.

Some examples of natural hazards:

• a flood (caused by overflowing rivers, storm surge, localised precipitation that cannot drain effectively, or by
engineering failure such as a dam or levee breach)

• an earthquake and the resulting ground shaking that is produced by it

• a tropical cyclone that causes high winds

• a tsunami

Some examples of non-natural hazards:

• a chemical spill

• a nuclear plant failure

1.1. PacSAFE Training Workshop - Tonga 9
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• an industrial fire / explosion

Vulnerability

Vulnerability is a measure of susceptibility to the impacts of a disaster event. This can take the form of structural
vulnerability for buildings and infrastructure hazards, and this is often a quantitative measure. The vulnerability of a
community is influenced by the characteristics and circumstances that make it susceptible to the damaging effects of a
disaster.

Vulnerability is measured in a range of ways, depending on the element in question. It is always related to the intensity
of the hazard (wind speed, ground shaking, etc.). For example, the vulnerability of a house can be measured by the
cost of repairs required, compared to the incident wind speed.

Social impacts are more difficult to quantify, because different communities may respond to a disaster in different
ways. Poverty and inequality, marginalisation, social exclusion and discrimination by gender, social status, disability,
pshcological factors and age (amongst other factors) are all factors that contribute to the vulnerability of a community.
These factors impact the ability to respond to and recover from a disaster. Quantified measures of social vulnerability
are limited, so it is more common to use qualitative descriptions.

Vulnerability and fragility: occasionally you may hear reference to the term fragility as well as vulnerability. Vul-
nerability is the expected level of damage that would be sustained if a given hazard magnitude affected an asset. The
vulnerability of a community is based on the characteristics and circumstances that make it susceptible to the dam-
aging effects of a hazard event. Fragility refers to the likelihood of a (qualitative) level of damage (e.g. no damage,
slight, moderate, extensive or complete damage). This can be translated into a quantitative estimate of the damage
(often referred to as a damage index or damage ratio).

Damage states

The damage state of an asset (e.g. people, buildings) is a qualitative description of the level of damage suffered by
a building (or components of a building). In some applications, the damage state is linked to a damage ratio, which
quantifies the damage as a fraction of the complete replacement cost of the building. In this case, it is possible to
determine the direct economic costs of a disaster, based on the accumulated damage.

An example of damage states for residential buildings for tropical cyclone winds:

In-
signifi-
cant

Little or no visible damage from the outside. No broken windows, or failed roof deck. Minimal loss of
roof cover, with no or very limited water penetration.

Light Moderate roof cover that can be covered to prevent additional water ingress. One window, door or
garage door broken.

Moder-
ate

Major roof damage, moderate window breakage. Minor roof sheathing failure. Some water damage to
interior.

Severe Major window damage or roof sheathing loss. Major roof cover loss. Extensive damage to interior from
water.

Com-
plete

Complete roof failure and/or failure of wall frame. Loss of more than 50% of roof sheathing.

Damage state descriptions are routinely used in post-event damage surveys, to ascertain the impacts of disasters.

Exposure

Exposure refers to the assets, populations, and other elements that are part of the landscape and may be impacted by a
hazard event. This can include things like buildings, people infrastructure and agriculture. For example exposure can
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refer to any or all of the following:

• Buildings: houses, public/government, commercial, industrial, cultural/religious, health, education, etc.

• People: number, demographics (age profile, gender, social disadvantage)

• Infrastructure: power, radio and telecommunications, water and sanitation, roads

• Agriculture: (commercial) crops, subsistence crops, forests, etc.

Often exposure is used to describe only those elements that are in the footprint of a hazard event. In some other
contexts, exposure is used to refer to all elements in a community.

Common sources of exposure information are government agencies (e.g. building approvals, infrastructure own-
ers/operators), surveys (including censuses) and aerial photos. Crowd-sourcing, through platforms like Open-
StreetMap has been used to great effect in Indonesia for collecting local level data, as well as validating larger-scale
data.

A key issue is open access to up-to-date, well-maintained geospatial exposure data. Without roads, buildings and
population data, a tool like InaSAFE would be impossible to use. It is critical for government to take a leading role in
making data freely available so it can be used for the benefit of their citizens.

Impact and risk

Impact

Impacts are the outcomes of a disaster on the community, it’s people, buildings, landscape and other assets. They can
be defined in qualitative terms, or quantitatively measured. Some indicators of impacts include:

• Economic loss

• Casualties, including physical injuries, deaths, mental breakdown

• Number of evacuees

• Damage to buildings, infrastructure, networks, etc.

• Business interruption period

• Intangible impacts such as community breakdown and loss of cultural identity

Risk

Risk is the likelihood that a loss will occur as a result of a hazard event, given the magnitude of hazard, exposed
elements and the vulnerability of those elements. Usually, it is quantified in terms of economic losses, where we use a
range of different measures to describe risk. It is intrinsically linked to the likelihood of a disaster event occuring, so
often the reported levels of risk link a loss level to a probability. Measures of risk include:

• Average annual loss - the average loss from disasters over a long period of time.

• Average reccurence interval loss - the loss expected to occur, on average, every 10, 50 or 100 years (or some
other frequency)

• Loss-exceedance curves - a graph of the loss from disasters compared to the chance of the disaster occuring.

Note: Impacts are the outcomes of a single disaster event on the community. Risk describes the likelihood of different
levels of impact due to different events.
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Impact and Risk Assessment

Impact and risk assessments are conducted to analyse the consequences of one (impact) or many (risk) hazard events,
with the goal of informing decisions on prevention, mitigation and response activities. It is an integral part of decision
and policy-making processes, and requires close collaboration among various parts of society to fully understand the
impacts and risks (UNDP).

The analysis of impacts, through the use of tools like InaSAFE, is only one step in a comprehensive risk assessment
process. A complete assessment includes hazard assessments, vulneraility analsyes, risk profiling and formulation of
disaster risk reduction strategies and plans. The reports created through InaSAFE can be used in formulating strategies
and action plans.

The disaster management cycle

The disaster management cycle is a continuous loop that connects four core elements in managing disasters.

• Prevention

• Preparedness

• Response

• Recovery

Fig. 1.4: The disaster management cycle.

Note: You may see other definitions of the disaster management cycle, which have other phases included in the loop.

12 Chapter 1. InaSAFE Training Documentation
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The core concept of a cyclic process remains the same.

Prevention is the activities and measures taken to avoid existing and new disaster risks.

Preparedness describes the knowledge and capacities of governements and communities to effectively anticipate,
respond and recover from the impacts of an imminent disaster.

Response is the actions taken directly before, during or immediately after a disaster to save lives, reduce health impacts
and ensure public safety for the people affected by a disaster.

Recovery describes the restoration and improvement of the economic, physical, social, cultural and environmental
assets, systems and activities of a community to avoid of reduce future disaster risk.

Represented in a cycle, the recovery phase leads into prevention, where the goals are the same – avoiding or reducing
future disaster impacts.

InaSAFE can be used to inform the preparedness and response phases of the disaster management cycle, by enabling
emergency management officers to plan for scenarios and improve the understanding of resources required to respond
quickly and effectively to a disaster.

More information on disaster risk concepts is available on the Understanding Disaster Risk site.

1.1.5 Introduction to QGIS

Introduction

QGIS is a user-friendly open source Geographic Information System (GIS). It runs on Linux, OS X, Windows and
Android. QGIS supports numerous vector, raster, database formats and provide extendable functionality. Learn more
about the project at: http://www.qgis.org

QGIS is great because:

• It is completely free. It doesn’t cost anything.

• It’s free, as in liberty. If you think a feature is missing, you can sponsor the development of a feature, or add it
yourself if you are familiar with programming.

• It’s constantly developing and improving. Because many people continue adding features, it keeps getting better.

• Extensive help and documentation is available. If you have problems you can always turn to the software
documentation, other QGIS users, or even the developers.

QGIS provides a continuously growing number of capabilities provided by core functions and plugins. You can
visualise, manage, edit, analyse data and compose printable maps. QGIS is also the platform which InaSAFE is built
on, and so this document focuses on building foundational skills using QGIS.

Learning objectives:

• Understand how to get QGIS

• Understand how to install QGIS

• Understand QGIS and its layout

• Understand QGIS toolbars and how to manage them

• Learn basic operation in QGIS

• How to install PacSAFE from QGIS
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• Introduction to the PacSAFE toolbar and functionality

Data for this exercise:

The data for this exercise is available in Introduction to QGIS.zip which can be downloaded in PacSAFE Training
Data Packages. To download QGIS, go to the QGIS Website (we will explain how to download and install QGIS later
in this exercise). We will use the following QGIS project and data:

1. DKI_Jakarta_Introduction.qgs

2. Jakarta_roads_WGS84.shp

3. Jakarta_Flood_18113_WGS84.shp

4. Jakarta_Flood_HKV_WGS84.tif

Exercises

1. Getting QGIS

For this workshop, we are providing the software for PacSAFE on a USB flash drive. However, you can download
QGIS software by accessing the main QGIS website:

• Open your web browser and in the address bar at the top of the window type qgis.org. Press Enter.

• The QGIS website will look something like this:

• Click Download Now.

• If you are using Windows, there are 2 versions of QGIS (version 2.14 and version 2.18). Choose Latest
release (eg. for new users) and click QGIS Standalone Installer Version 2.18 (32 bit or 64 bit
depend your computer operating system). Your exact version number may be different.

14 Chapter 1. InaSAFE Training Documentation
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• If you are not using Windows, select your operating system from the menu. Follow the installation instructions.

2. Installing QGIS

After you download the QGIS software installer, the next step is to install QGIS to your computer.

• Open the folder where you have the QGIS installation file. Where we have provided the USB drive, open that
folder.

• Run the installation file. If you are installing QGIS version 2.x, it should look something like this:

1.1. PacSAFE Training Workshop - Tonga 15
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• Click Next and follow the instructions.

• Once the installation is finished, you can open your QGIS in Start Menu.

• QGIS will look something like this:

16 Chapter 1. InaSAFE Training Documentation
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3. Understanding QGIS interface

Next, we will introduce the main QGIS interface. In general, there are four elements in QGIS:

1. Layers Panel: On the left side of QGIS is the layers panel. This panel lists the layers, or files, that are loaded
into our QGIS project. The Layers Panel not only shows all the files that are currently open, it also determines
the order that they will be drawn on the map canvas. A layer that is at the bottom of the list will be drawn first,
and any layers above it will be drawn on top.

1.1. PacSAFE Training Workshop - Tonga 17



PacSAFE Documentation

2. Toolbar: At the top of QGIS are a large number of tools, which are contained within various toolbars. For
example, the File toolbar allows you to save, load, print and start a new project. We already used one of these
tools when we opened this project.

By hovering your mouse over an icon, the name of the tool will appear to help you identify each tool. The number of
tools (buttons) can seem a bit overwhelming at first, but you will gradually get to know them. The tools are grouped
into related functions on toolbars. If you look closely you can see a vertical array of ten dots to the left of each toolbar.
By grabbing these with your mouse, you can move the toolbar to a more convenient location, or separate it so that it
sits on its own.

3. Map Canvas: All of the map data that we load into QGIS will be displayed here, both vector data and raster
data.

4. Status bar: The status bar shows information about the current map. It allows you to adjust the map scale and
see the mouse cursor’s coordinates on the map.

The coordinates of this map are the same type of coordinates that are recorded by GPS devices. The status bar shows
the longitude and latitude of your mouse cursor.

4. Manage toolbars

At the top of QGIS are a large number of tools, which are contained within various ‘toolbars.’ For example, the File
toolbar allows you to save, load, print, and start a new project. We already used one of these tools when we opened
this project.

By hovering your mouse over an icon, the name of the tool will appear to help you identify each tool.

The number of tools (buttons) can seem a bit overwhelming at first, but you will gradually get to know them. The tools
are grouped into related functions on toolbars. If you look closly you can see a vertical array of ten dots to the left of
each toolbar. By grabbing these with your mouse, you can move the toolbar to a more convenient location, or separate
it so that it sits on its own.
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If you feel overwhelmed by the number of toolbars, you can customize the interface to see only the tools you use most
often, adding or removing toolbars as necessary.

To add or remove a toolbar, right-click on empty space in toolbars, or go to View → Toolbars.

Rearrange the toolbar so that it’s on one line. Left-click and hold the vertical dots on the left hand side of the tool.
Drag to the first line of the toolbar.

5. QGIS basic tools

We’ve already taken a look at the QGIS toolbar and have seen the tools for opening QGIS. Here’s a list of some of
the most commonly used tools. Feel free to play around with them if you like. The important thing for now is to start
getting familiar with QGIS.

Add Vector Layer Add vector data to Layer List
Add Raster Layer Add raster data to Layer List
New Create new QGIS project
Open Open QGIS project
Toggle Editing Edit features in a layer
Pan Map Drag the map to a new location
Zoom In Zoom in on the map
Zoom Out Zoom out on the map
Zoom Full Zoom so that all layers fit in the map window
Identify features Identify the attribute of an active layer in the map canvas
Open Attribute Table Open a layer’s attribute table
Select Single Feature Select a feature in the selected layer

6. Navigating the map

Before we examine the attributes of individual features, let’s take a quick look at how to navigate the map. The main
controls for moving the map around and zooming in-and-out are on the panels at the top of QGIS by default.

When you click on one of these buttons, it changes the action of your mouse in the main map window.

• Select the first button that looks like a hand. Now hold the left mouse button down and drag the mouse in the
map window. This allows you to pan the map, or move it around.

• Select the button that has a plus (+) sign inside a magnifying glass allows you to zoom in on the map. Using
your mouse, draw a box around your area of interest and release your mouse.

• The button that has a minus (-) sign inside a magnifying glass allows you to zoom out on the map. Select this
button and click on the map.

• The button that looks like a magnifying glass with blue arrows pointing away from it lets you zoom to the full
extent of your map. Click this button to see all the data that is loaded in the project fit into the map canvas.

We can always change the QGIS projection based on the projection of the data. It makes it easier to edit our data in
further steps if QGIS has the same projection as the data.
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7. Hide and move layers

Sometimes if you handle many layers, you need to hide/unhide layers to make the map canvas more organized. For
example, open the pre-saved QGIS project, DKI_Jakarta_Introduction.qgs. Once all the data are displayed
on your map canvas, try toggling the layer, a flood similar to the 2007 Jakarta Event by clicking on the checkbox in
the Layers Panel on the left side of your screen.

After you uncheck the check box, the layer will disappear from the map canvas. This operation won’t remove your
layer from the layers list but only hide it temporarily until you recheck again the check box. Try to turn ON the layer
again to unhide the layer.

What if your layer does not appear in the map canvas even though you already turned ON your layers? In this example,
the Jakarta_roads_WGS84 layer didn’t appear in Map Canvas even though it’s already turned ON. In this case, it’s
related to layer order. The layers in your Layers List are drawn on the map in a certain order. The layer at the bottom
of the list is drawn first, and the layer at the top is drawn last. By changing the order of the layers in the list, you can
change the order they are drawn in.

For example in this layer order. . .

. . . would result in Jakarta_roads_WGS84 being hidden as they position underneath A Flood in Jakarta like 2013.
To solve this problem, simply click the Jakarta_roads_WGS84 layer and drag to the top of the Layer List or reorder
them to the correct order.

What do you see after you move the Jakarta_roads_WGS84 layer?

You can see the road network now because the Jakarta_roads_WGS84 layer is shown above the other layers.

8. Symbolize layer

The symbology of a layer is its visual appearance on the map. One of the basic strengths of GIS is that you have a
dynamic visual representation of the data you’re working with. Therefore, the visual appearance of the map (which
depends on the symbology of the individual layers) is very important. For example in the project that you currently
have open, DKI_Jakarta_Introduction.qgs, you will see the A Flood in Jakarta like 2013 layer covering
the area of DKI Jakarta. Did the flood really cover the whole of DKI Jakarta?

To answer this, let’s turn OFF the Jakarta_roads_WGS84 and A Flood Similar to the Jakarta 2007 event layers
and open the attribute table of A Flood in Jakarta like 2013 by right clicking the layer and selecting Open Attribute
Table. You will see there are 6 columns in this table and one of the columns has the name ‘affected’ with values of 1
and 0. A value of 1 represents an area that is flooded, while a value of 0 represents an area that has not been flooded.
Let’s select a feature in this layer and see the highlighted feature in the attribute table.

What is the value of the selected feature in the attribute table?

Not all of the features in this dataset have a value of 1 (or flooded). You need to see which features have a value of 1
to make it easier to interpret the hazard area. To solve this problem, we will symbolize the data so it will only shows
the flooded area.

1. Right click on the A flood in Jakarta like 2013 layer and select Properties.

2. Go to the Style tab and and change Single Symbol into Categorized.

3. Select affected in Column as the column that we will use to categorize the data.
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4. Click classify and turn off the values that have a value of 0 or no value.

5. Click OK

After you click OK, only features that have a value of 1 (flooded) will be displayed on the map canvas, the other values
won’t be shown on the map canvas because you turned OFF the symbol that represents a value of 0. Symbology helps
us better understand the data that we will work on.

9. PacSAFE installation and set up

As we know, the PacSAFE plugin has been built for QGIS. It is one of the plugins which are available in the QGIS
Repository. Make sure that you have a working internet connection before you follow the steps below. To get PacSAFE
please follow these steps:

• Go to Plugins -> Manage and install plugins menu.

• Go to the search box and type PacSAFE.

• Select PacSAFE and click Install plugin and wait for a moment until the PacSAFE dock appears in the right
side of QGIS main window.

• Close the plugin manager window.

Congratulations! Now you have PacSAFE installed in QGIS.

10. PacSAFE toolbars

After successfully installing PacSAFE, you should now have an PacSAFE dock on the right hand side of your screen.
It should look like this:

PacSAFE also comes with a toolbar of its own! To retrieve the PacSAFE toolbar, you can right-click on the top toolbar
and check PacSAFE.

PacSAFE Dock
Set Analysis Area
Toggle Scenario Outline
Keyword Creation Wizard
Impact Function Centric Wizard
OpenStreetMap Downloader
Add OpenStreetMap Tile Layer

Later we will explore and use these tools in Run Basic PacSAFE and Intermediate Modules.

Summary

In this exercise you have learned about QGIS, the free and open source software for processing spatial data. You have
learned where to get QGIS, how to install QGIS, understand the QGIS layout and looked at some useful toolbars,
learning how to turn ON/OFF QGIS layers, and learned how to symbolize the data layers.

We also learned how to install PacSAFE through the QGIS plugin manager. Later on we will learn how to operate
PacSAFE with DKI NUkualofa tsunami scenario.
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1.1.6 Introduction to PacSAFE

Introduction

This session will introduce the InaSAFE application to participants. We will guide you through the process of installing
InaSAFE, walk you through the main interface and demonstrate some basic operations you can perform in InaSAFE.

Learning objective

To introduce participants to the process of installing InaSAFE and basic functionality and navigation in the application.
By the end of this exercise, participnts will:

• Understand how to install PacSAFE

• Explore the PacSAFE toolbar and functionality

• Learn basic operations in PacSAFE

Data for this exercise

No data is needed for this exercise. The facilitators will provide the InaSAFE application.

Exercises

Getting PacSAFE

PacSAFE can be downloaded from http://services.gsd.spc.int/pacsafe/

For this workshop, we are providing the whole PacSAFE application via a USB key, along with the required datasets
for the scenarios that will be explored.

Installing PacSAFE

Copy the contents of the USB to a location on your computer, extract the files and run the installer.

Starting PacSAFE

Start InaSAFE by double clicking the InaSAFE icon on the desktop.

A splash screen will appear for a few seconds, then the main InaSAFE interface will be displayed.
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Understanding the InaSAFE interface

InaSAFE is based on the Geographic Information System (GIS) software package QGIS and the InaSAFE plugin. The
main InaSAFE interface uses the QGIS interface, with a reduced number of toolbars to make the interface easier to
navigate for non-specialists.

There are four elements in the PacSAFE interface:

1. Layers panel: On the left side of PacSAFE is the layers panel. This panel lists the layers, or files, that are
loaded into our PacSAFE project. The Layers Panel not only shows all the files that are currently open, it also
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determines the order that they will be drawn on the map canvas. A layer that is at the bottom of the list will be
drawn first, and any layers above it will be drawn on top.

2. Toolbar: At the top of PacSAFE are a large number of tools, which are contained within various toolbars. For
example, the File toolbar allows you to save, load, print and start a new project, under the Project and Plugins
dropdown menus. We already used one of these tools when we opened this project. By hovering your mouse
over an icon, the name of the tool will appear to help you identify each tool.

3. Map canvas: All of the map data that we load into PacSAFE will be displayed here, both vector data and raster
data.

4. PacSAFE dock: After successfully opening PacSAFE, you should have a PacSAFE dock on the right hand
side of the screen. It should look like this:

Screenshot of PacSAFE dock

PacSAFE basic tools

We’ve already taken a look at the QGIS toolbar and have seen the tools for opening QGIS. Here’s a list of some of
the most commonly used tools. Feel free to play around with them if you like. The important thing for now is to start
getting familiar with QGIS.

The InaSAFE button gives you access to the pre-compiled projects delivered with InaSAFE. Clicking on the InaSAFE
button will open a new window with a list of projects to select from.

Fig. 1.5: Project selection window for PacSAFE.
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Select the “Nukualofa tsunami buildings” project in the list, then click the Load button.

The project will show several layers in teh Layers panel, including:

• Buildings: this is the exposure data. This will be used to assess the tsunami impact on buildings.

• Tsunami: this is the hazard data. It is used to determine the inundation depth from a tsunami.

• Imagery: this is contextual data, and is aerial imagery over Nuku’alofa. This provides a sense of place and scale
when viewing the results of analysis. It is not used in the analysis.

Navigating the map

Before we examine the attributes of individual features, let’s take a quick look at how to navigate the map. The main
controls for moving the map around and zooming in-and-out are on the panels at the top of QGIS by default.

When you click on one of these buttons, it changes the action of the mouse in the main map window.

• Select the first button that looks like a hand. Now hold the left mouse button down and drag the mouse in the
map window. This allows you to pan the map, or move it around.

• Selecting the button that has a plus sign (+) inside a magnifying glass allows you to zoom in on the map. Using
your mouse, draw a boz around your area of interest and release your mouse.

• Selecting the button with a minus sign (-) inside a magnifying glass allows you to zoom out on the map. Select
this button and click on the map.

• The button that looks like a magnifying glass with blue arrows pointing away from it lets you zoom to the full
extent of your map. Click this button to see all the data that is loaded in the project fit into the map canvas.

Hide and move layers

Sometimes if you handle many layers, you need to hide/unhide layers to make the map canvas more organized. For
example, open the pre-saved QGIS project, DKI_Jakarta_Introduction.qgs. Once all the data are displayed on your
map canvas, try toggling the layer, Tsunami from a Mw 9.0 earthquake by clicking on the checkbox in the Layers
Panel on the left side of your screen.

After you uncheck the check box, the layer will disappear from the map canvas. This operation won’t remove your
layer from the layers list but only hide it temporarily until you recheck again the check box. Try to turn ON the layer
again to unhide the layer.

What if your layer does not appear in the map canvas even though you already turned ON your layers? In this example,
the Jakarta_roads_WGS84 layer didn’t appear in Map Canvas even though it’s already turned ON. In this case, it’s
related to layer order. The layers in your Layers List are drawn on the map in a certain order. The layer at the bottom
of the list is drawn first, and the layer at the top is drawn last. By changing the order of the layers in the list, you can
change the order they are drawn in.

Symbolize a layer

The symbology of a layer is its visual appearance on the map. One of the basic strengths of GIS is that you have a
dynamic visual representation of the data you’re working with. Therefore, the visual appearance of the map (which
depends on the symbology of the individual layers) is very important. For example in the project that you currently
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have open, DKI_Jakarta_Introduction.qgs, you will see the A Flood in Jakarta like 2013 layer covering
the area of DKI Jakarta. Did the flood really cover the whole of DKI Jakarta?

To answer this, let’s turn OFF the Jakarta_roads_WGS84 and A Flood Similar to the Jakarta 2007 event layers
and open the attribute table of A Flood in Jakarta like 2013 by right clicking the layer and selecting Open Attribute
Table. You will see there are 6 columns in this table and one of the columns has the name ‘affected’ with values of 1
and 0. A value of 1 represents an area that is flooded, while a value of 0 represents an area that has not been flooded.
Let’s select a feature in this layer and see the highlighted feature in the attribute table.

What is the value of the selected feature in the attribute table?

Not all of the features in this dataset have a value of 1 (or flooded). You need to see which features have a value of 1
to make it easier to interpret the hazard area. To solve this problem, we will symbolize the data so it will only shows
the flooded area.

1. Right click on the A flood in Jakarta like 2013 layer and select Properties.

2. Go to the Style tab and and change Single Symbol into Categorized.

3. Select affected in Column as the column that we will use to categorize the data.

4. Click classify and turn off the values that have a value of 0 or no value.

5. Click OK

PacSAFE toolbar

PacSAFE also comes with a toolbar of it’s own! To retrieve the PacSAFE toolbar, you can right-click on the top
toolbar and check PacSAFE.

PacSAFE Dock

Set Analysis Area

Toggle Scenario Outline

Keyword Creation Wizard

Impact Function Centric Wizard

OpenStreetMap Downloader

Add OpenStreetMap Tile Layer

Later, we will explore and use these tools in Run basic PacSAFE and Intermediate modules.

Summary

In this exercise you have learned about QGIS, the free and open source software for processing spatial data. You have
learned where to get QGIS, how to install QGIS, understand the QGIS layout and looked at some useful toolbars,
learning how to turn ON/OFF QGIS layers, and learned how to symbolize the data layers.
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1.1.7 Running InaSAFE with other hazards

Introduction

InaSAFE was designed to predict the result of a disaster by giving us the potential impact on buildings, populations
and roads based on specific scenarios. From previous exercises, we have learned how to use Basic and Intermediate
InaSAFE functionality. We also learned about using tools in InaSAFE such as define keywords, configure minimum
needs and area analysis, using aggregation as well as many others.

In previous exercises, we used the “tsunami in Nuku’alofa” scenario and related data to learn InaSAFE functionality.
In addition to tsunami, InaSAFE impact analyses can be run for many hazard types including earthquakes, cyclones
and volcanos. In this exercise, we will explore and learn to run other hazard scenarios in InaSAFE using InaSAFE
dock and InaSAFE Function Centric Wizard. Last but not least, we will also use the Generic Impact Function.

Learning objectives:

To improve the participant’s understanding of how to use InaSAFE to run impact analyses for hazards other than
floods. By the end of this exercise, participants will be able to:

• Run InaSAFE with other hazards such as Earthquakes, Tropical Cyclones and Volcanos;

• Be able to read metadata and assign keywords to hazard data;

• Be able to use the InaSAFE dock and the InaSAFE Function Centric Wizard; and

• Be able to use the Generic Impact Function and understand how to use it to work with their own data.

1.1.8 Workshop #1 Participants Questionnaire

To help us give you the best possible workshop, we would like to understand your current knowledge of Geographic
Information Systems (GIS) and Disaster Risk Management (DRM) concepts as well as the type of work you and your
organisation do. There are no right or wrong answers. Your responses will help us plan the workshop to your needs.
Please add as much detail as possible and if you do not know the answer to a question, indicate this and we will ensure
to add it to the workshop.

images/pre_workshop_1.jpg
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1.1.9 Workshop #1 Evaluation Questionnaire

Thank you for attending this workshop. Your feedback is important to us and will help improve the content for future
workshops. If you have anything further to add, please speak with your instructor.

images/post_workshop_1.png

images/post_workshop_2.png

1.2 This is workshop 2

Tonga, October 2017

InaSAFE Workshop #2 to be hosted by the National Emergency Management Office, Tonga October 2017. Material
to be prepared by Geoscience Australia and SPC, based on the InaSAFE training programs prepared by Kartoza.

Preface
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1.3 This is workshop 3

Tonga, TBD 2018

InaSAFE Workshop #3 to be hosted by the National Emergency Management Office, Tonga 2018. Material to be
prepared by Geoscience Australia and SPC, based on the InaSAFE training programs prepared by Kartoza.

Preface

Contents
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CHAPTER 2

InaSAFE User Documentation

User guides and documentation are maintained here.

• qGIS

• InaSAFE

2.1 InaSAFE User Guide

Place holder for the PacSAFE User Guide

2.1.1 Installing the InaSAFE plugin

How to install PacSAFE Plugin

• Prerequisites

• Credits

2.1.2 Adding new projects to InaSAFE

Users can add new QGIS projects to the list of projects for use in InaSAFE

Use the pacsafe-advanced.bat version to create your project, as this will allow you to update elements such as the
project title and ensure the project uses relative paths.

Follow these guidelines to add your own projects:

1. Projects should be named with underscores _ instead of spaces. Set the name to something meanigful, so other
people might understand what the project comprises
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2. All data should be stored under subdirectories where the project is saved. Currently, there are a limited number
of subfolders, to make maintaining the data easier. New exposure data should be stored under the exposure
folder, raster holds the raster hazard layers, imagery stores the satellite imagery used for context in the
projects.

3. Make sure the project stores the path to the data layers as relative paths. Go to Project → Project properties →
General settings → Save paths and ensure it is set to “relative”.

4. Set the title of the project to something meaningful, so other people might understand what the project com-
prises: Project → Project properties → General settings → Project title

5. Copy the project file, and any additional data, to the data/to folder (for Tonga projects).

When you next start InaSAFE, your project should appear in the Project Selection window.

2.1.3 Data Requirements

This document describes the data requirements of InaSAFE in regard to what inputs are needed to carry out an analysis.

At the highest level InaSAFE will take a hazard layer (such as ground shaking, water depth or ash load) and an
exposure layer (such as population density or building footprints) and combine them according to an impact function
to produce an impact layer and a report.

Hazard layers

The supported hazard layers are:

Hazard Spatial type Hazard type Attribute name Hazard units/fields Parameters
Volcano Raster Ash load N/A kg/m^2
Volcano Point Distance from vent Name text Radius [km]
Volcano Polygon Category KRB text
Earthquake Raster Shakemap N/A MMI
Flood Raster Depth N/A m Threshold [m]
Flood Polygon Wet/Dry affected 1/0 Threshold [%]
Tsunami Raster Depth N/A m Threshold [m]
Cyclone Raster Wind speed N/A m/s Category

Exposure layers

Exposure Spatial type Exposure type Attribute name Hazard units/fields
Population Raster Density N/A People per pixel
Structures Point Structure type type text
Structures Polygon Structure type type text
Roads Polyline Road type type text
Land cover Polygon Land cover type type text

2.1.4 Writing Documentation

The documentation for InaSAFE is written using ReSTructured text (.rst) and the Sphinx documentation builder.

The best way to learn how to write .rst is to look at the source of existing documentation - the markup syntax is very
simple. There are a number of useful tags that you can use to make your documentation clear and visually interesting,
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the more commonly used in this document are listed below. For a more detailed list, please visit the Sphinx Inline
Markup page

A complete list of supported .rst markup is also available here.

Following are a few tips for documentation writers:

1. Take a look in the lookup table to see which terms and phrases are used and which you should definitely not
translate.

2. There is a “Community Edition” of PyCharm available. Consider using this for writing documentation.

3. Try to not write more than 80 Characters in one line. That makes the documentation much easier to maintain.

4. Try to create a reference anchor for at least every new heading (page). If it is useful and important you might
also want to put anchors on subheadings.

5. Try to avoid duplicate target names (anchors). Always use unique identifiers. If you are not sure - the longer the
name the more unlikely it is already used.

6. Try to use underscores (_) in filenames and links (anchors) as a separator.

7. Try to use dashes (-) in directory names as a separator.

8. Try to avoid using tables wherever possible. Only use tables if there is really no other way to display the
documentation.

9. If you have to use tables try to avoid using TABS in favour of SPACES. TABS only confuse the computer while
building documentation and leads to unnecessary errors.

Common tags used in the Documentation:

Here are some common useful tags

|project_name| is currently a substitution for the Project name (PacSAFE)
Normally, there are no heading levels assigned to certain characters as the
structure is determined from the succession of headings. However, for the
Python documentation, this convention is used which you may follow:

# with overline, for parts

* with overline, for chapters

First two are normaly not used as we usually start with a section.

=, for sections
-, for subsections
^, for subsubsections
", for paragraphs

Section
=======

SubSection
----------

Subsubsection
.............

Subsubsubsection (if needed)
^^^^^^^^^^^^^^^^^^^^^^^^^^^^

(continues on next page)
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(continued from previous page)

**bold**

*italics*

`web link<http://foo.org>`_ Link to a named external reference

:ref:`my-reference-label` points to a reference which has to be
implemented like:

.. _my-reference-label: The anchor for the :ref: needs to be
in front of a Section.

Section to cross-reference Like it is here.
--------------------------

:ref:`title <my-reference-label>` Same as above except using the Title and
not the referenced headline.

:doc:`../user-docs/filename` referencing an internal file

:samp:`flood [m]` A piece of literal text, such as code.

:menuselection:`Plugins --> Manage Plugins` This is used to mark a complete
sequence of menu selections,
including selecting submenus.

:guilabel:`OK` Labels presented as part of an interactive user interface
should be marked using guilabel.

:kbd:`Control-x Control-f` Mark a sequence of keystrokes.

:command:`rm` (The name of an OS-level command, such as rm.)

:file:`/etc/fstab` to change something

.. note:: Note in a little call out box

.. todo:: Todo item in a call out box

.. warning:: Much like Note but clearly visible

There are more markers available:

.. attention::

.. caution::

.. danger::

.. error::

.. hint::

.. important::

.. tip::

.. table:: table title

============ ================
Key Allowed Values

============ ================
units m

(continues on next page)
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(continued from previous page)

units wet/dry
units feet
============ ================

+-----------------------+-----------------------+
| Symbol | Meaning |
+=======================+=======================+
| .. image:: tent.* | Campground |
+-----------------------+-----------------------+
| .. image:: waves.* | Lake |
+-----------------------+-----------------------+
| .. image:: peak.* | Mountain |
+-----------------------+-----------------------+

figure and images are easily exchangeable when using * instead of jpg or
png. In that way the Pictures can be exchanged to a new format without
changing the source code.

.. figure:: picture.*
:scale: 50 %
:alt: map to buried treasure
:figwidth: lenght or percentage of current line width
:figclass: text

This is the caption of the figure (a simple paragraph).

.. image:: /static/tutorial/001.*
:height: 100 px
:width: 200 pt
:scale: 50 %
:alt: alternate text
:align: center

remark: use pt instead of px because of latex output A4 = height ~ 1000pt A4 = width ~ 700pt

Help writing/fixing documentation

Helping writing the documentation is an easy task. The only thing you need to have is a local copy of the InaSAFE
documentation branch.

Clone InaSAFE documentation

In order to clone the documentation of InaSAFE you only have to follow this procedure:

Note: This is a one-time process. You do not need to repeat it - it is here for reference purposes only.

Things you have to have to be able to help with documentation:

• A GitHub account

• A fork of the pacsafe-doc branch (only if you do not have commit access to the main repository)

Creating a GitHub account is done by clicking on the Sign up for free button on https://github.com/ and filling out the
necessary fields.
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This documentation assumes that you have the whole InaSAFE source available under $HOME/dev/python/...

Clone your forked github InaSAFE documentation by entering following command:

git clone https://github.com/<your username>/pacsafe-doc.git

Search for the .rst file you’d like to extend/fix and work on it.

Afterwards commit your local changes to your local clone with the command:

git commit -a -m"fixed a typo"

After that you have to push your local changes to your github fork with:

git push

You can than do a pull request on github to request your changes to be reviewed and taken into the official documen-
tation.
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The InaSAFE Project

The InaSAFE Project is a response to demand from Pacific Island Countries as a part of the suite of tools envisaged
under the Secretariat of Pacific Community Geoscience Division’s Pacific Risk Information System. The Project
will collaborate with representatives from the Fijian National Disaster Management Office (NDMO) and the Tongan
National Emergency Management Office (NEMO) in the planning, preparation and response to natural disasters.
The InaSAFE software tool is a QGIS plugin leveraging the capabilities of InaSAFE. It was originally designed and
developed by SPC and together with Geoscience Australia, the Australian Government’s technical geoscience agency
will continue the development and deployment of PacSAFE.

3.1 Tonga

Information regarding the Tongan Workshops

3.1.1 Datasets

The data used in this course is provided on the supplied USB flash drive. Ask your trainer for asssistance if you have
problems locating the data.
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Hazard data

Tsunami model

File name
Fdepth8.7c_1.asc

Training data
Tsunami inundation from a Mw 8.7 earthquake

Geometry
Raster

Data type
Continuous

Units
Metres

Source
Geoscience Division, SPC

Date
2013

URL
http://gsd.spc.int

Licence
Creative Commons by Attribution (CCbyA)

Coverage
Tongatapu

Description
The tsunami inundation model was created by scientists
in coordination with NEMO, based on a scenario of an
Mw8.7 earthquake. The depth is the maximum depth
occuring across the inundation period.
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File name
Fdepth9.0c_1.asc

Training data
Tsunami inundation from a Mw 9.0 earthquake

Geometry
Raster

Data type
Continuous

Units
Metres

Source
Geoscience Division, SPC

Date
2013

URL
http://gsd.spc.int

Licence
Creative Commons by Attribution (CCbyA)

Coverage
Tongatapu

Description
The tsunami inundation model was created by scientists
in coordination with NEMO, based on a scenario of an
Mw9.0 earthquake. The depth is the maximum depth
occuring across the inundation period.
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Cyclone model

File name
tc_ian.tif

Training data
TC Ian

Geometry
Raster

Data type
Continuous

Units
Metres per second (m/s)

Source
Geoscience Australia

Date
2017

URL
http://www.ga.gov.au

Licence
Creative Commons by Attribution (CCbyA)

Coverage
Tonga

Description
The cyclone model was created using the Tropi-
cal Cyclone Risk Model (TCRM - http://github.com/
GeoscienceAustralia/tcrm), based on the best track of
TC Ian (2014). The wind speed represents the maxi-
mum gust wind over the period of the cyclone.
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File name
scenario-01.tif

Training data
A category 5 cyclone

Geometry
Raster

Data type
Continuous

Units
Metres per second (m/s)

Source
Geoscience Australia

Date
2017

URL
http://www.ga.gov.au

Licence
Creative Commons by Attribution (CCbyA)

Coverage
Tonga

Description
The cyclone model was created using the Tropi-
cal Cyclone Risk Model (TCRM - http://github.com/
GeoscienceAustralia/tcrm), based on a random collec-
tion of synthetic cyclones generated for the Tonga re-
gion. The wind speed represents the maximum gust
wind over the period of the cyclone.
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Exposure data

Buildings

File name
to_buildings.shp

Training data
Buildings

Geometry
Point

Data type
Classified

Source
PCRAFI

URL
http://pcrafi.spc.int

Date
2010

Coverage
Tonga
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Population

File name
World_Population

Training data
Tonga population

Geometry
Raster

Data type
Continuous

Unit
Count

Source
World Pop

URL
http://worldpop.org.uk

Date
2010

Licence
Creative Commons by Attribution (CCbyA)

Coverage
Tonga

Description
High resolution (1 pixel represents 100m x 100m, con-
temporary data on human population distributions are
a prerequisite for the accurate measurement of the im-
pacts of population growth, for monitoring changes and
for planning interventions. The AsiaPop project was ini-
tiated in July 2011 with the aim of producing detailed
and freely-available population distribution maps for the
whole of Asia. This project has expanded as the World
Pop project to include other continents.
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Aggregation data

Administrative boundaries

Name
Administrative Boundary

Training data
Villages

Geometry
Polygon

Data type
Classified

Attribute field
Village

Attribute value map
toponymy of the area

Source
PCRAFI

URL

Date
2010

Licence

Coverage

Description
Administrative boundaries in Tonga

3.2 Fiji

Information regarding the Fijian Workshops
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PacSAFE is supported by the Pacific Community and the Government of Australia
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